
Welcome to PCoIP Software Client for Windows

Welcome to the Software Client for Windows Administrators' Guide.

PCoIP Software Clients are applications that establish PCoIP sessions with remote Windows,

Linux, or macOS desktops. Connections can be made to PCoIP agents installed on virtual or

physical machines, or to Remote Workstation Cards in physical workstations.

This guide explains how to install, configure, and use the Software Client for Windows. It includes

client system requirements and information on host dependencies.

Who Should Read This Guide?

This guide is intended for administrators and users who install, configure, or use the Software

Client for Windows.

Additional Documentation

The following guides contain additional information relevant to PCoIP systems and PCoIP

Software Clients:

For more information about HP Anyware, including detailed information on included PCoIP

components as well as HP Anyware plans, see the Teradici Cloud Access Architecture Guide.

For more information about Teradici PCoIP agents, which are required on remote virtual machines,

see the following pages:

• Teradici PCoIP Graphics Agent for Windows

• Teradici PCoIP Graphics Agent for Linux

• Teradici PCoIP Graphics Agent for macOS

• Teradici PCoIP Standard Agent for Windows

• Teradici PCoIP Standard Agent for Linux

Welcome to PCoIP Software Client for Windows
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https://www.teradici.com/web-help/pcoip_agent/graphics_agent/windows/22.07/
https://www.teradici.com/web-help/pcoip_agent/graphics_agent/linux/22.07/
https://www.teradici.com/web-help/pcoip_agent/graphics_agent/macos/22.07/
https://www.teradici.com/web-help/pcoip_agent/standard_agent/windows/22.07/
https://www.teradici.com/web-help/pcoip_agent/standard_agent/linux/22.07/


For information about Teradici PCoIP Remote Workstation Card Software, which is required on

remote workstations using a Teradici PCoIP Remote Workstation Card, see the following pages:

• PCoIP Remote Workstation Card Software for Windows

• PCoIP Remote Workstation Card Software for Linux

Additional Documentation
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https://docs.teradici.com/find/product/remote-workstation-card/current/remote-workstation-card-software-for-windows
https://docs.teradici.com/find/product/remote-workstation-card/current/remote-workstation-card-software-for-linux


What's New in This Release

The PCoIP Software Client for Windows 22.07 introduces the following features and

enhancements:

• HP Anyware: With this release, Teradici CAS is now HP Anyware. HP Anyware brings Teradici

CAS and ZCentral Remote Boost together into a single solution, starting with enhancements

for the collaboration feature.

• Collaboration Enhancements: There are two major improvements to collaboration in this

release:

◦ The PCoIP Client for Software Client for Windows now supports GPU Offload and Auto

Offload PCoIP Ultra modes in collaboration sessions, if the connected PCoIP agent also

supports them. 

◦ Mouse visibility has also been added in this release; Guest collaborators can now see the

host's cursor movements during a collaboration session.

See Collaboration for more information on these enhancements.

• URI-launched session configuration improvements: When launching the Software Client for

Windows via a URI, you can now use most of the same properties available to command-line

launches in your JWT payload. For more information, see Command Line Parameters.

What's New in This Release
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System Requirements

The following table outlines the system requirements for the PCoIP Software Client for Windows:

Hardware System Requirements

For different display configurations Teradici recommends certain processor and RAM

combinations:

• For up to dual 1920 x 1080 display configuration Teradici recommends 1.6 GHz dual core

processor or higher with at least 4 GB RAM.

• For up to dual 4K/UHD Teradici recommends a 3.0 Ghz quad core processor or higher with at

least 2 x 4 GB RAM. 

1. For details on feature limitations between PCoIP Software Clients and PCoIP Remote Workstation Cards, see 

Connecting to PCoIP Remote Workstation Cards. 

System Version Required

PCoIP Software Client

Operating Systems
• Windows 10 (64-bit)

• Windows 11

Compatible PCoIP Agents The Software Client for Windows can connect to any PCoIP agent. Some features

require specific agent versions; see the Feature Support section of this guide for

details. 

We recommend always using the same version of PCoIP agent and PCoIP client.

Compatible PCoIP Remote

Workstation Cards

TERA22x0 with firmware 20.04+ and PCoIP Remote Workstation Card Software for

Windows or Linux 20.04+.

Supported IP versions IPv4 and IPV6.

1
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Audio Support

Stereo audio output and mono audio input are supported and enabled by default.

The PCoIP Client provides an enhanced audio and video synchronization (A/V Sync) feature that

provides improved full-screen video playback, reducing the difference in delays between the audio

and video channels and smoothing frame playback on the client. This improves lip sync and

reduces video frame drops for movie playback. This feature introduces a small lag in user

interaction responsiveness when enabled. Using enhanced audio and video synchronization will

reduce the maximum frame rate.

Audio input devices should not be bridged to the remote session. Audio input devices are locally

terminated and utilize local OS audio drivers. A bluetooth headset can be supported locally, but

cannot be bridged.

For more information on the A/V Sync feature, see Enhanced Audio and Video Synchronization.

Audio Support
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Collaboration

The PCoIP Ultra Collaboration feature enables a user to share their PCoIP session with a remote

guest collaborator using a PCoIP Software Client. While connected, the guest collaborator can

view the screen output and hear the audio output of the shared PCoIP session. 

When discussing this feature, we'll refer to the first user as the host collaborator, and the second

user who joins the session as the guest collaborator.

Enabling and Hosting a Collaboration Session

For information and steps on how to enable collaboration, and how to host a collaboration

session, see the PCoIP Agent documentation linked below. The instructions for enabling and

hosting collaboration will vary based on the PCoIP Agent you use. You should select the

instructions that apply to the PCoIP Agent that you are connecting to:

• PCoIP Graphics Agent for Linux - Collaboration

• PCoIP Graphics Agent for macOS - Collaboration 

• PCoIP Graphics Agent for Windows - Collaboration

• PCoIP Standard Agent for Linux - Collaboration

• PCoIP Standard Agent for Windows - Collaboration

Feature Support, Requirements and Limitations

• The PCoIP Ultra Collaboration feature is supported when connecting from any PCoIP software client to any PCoIP

agent.

• When connecting to a PCoIP standard agent, PCoIP Ultra CPU Offload is required.

• When connecting to a PCoIP graphics agent 22.07 or later, PCoIP Ultra CPU Offload, GPU Offload, and Auto

Offload are supported.

• Collaboration Mouse Visibility only works when the host collaborator and all guest collaborators are using a

PCoIP Client in Standard Client mode. The high performance client mode does not support mouse visiblity. 

The features described on this page are only supported when both PCoIP Clients and PCoIP Agents are running on

version 22.07 or later. 



Collaboration
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https://www.teradici.com/web-help/pcoip_agent/graphics_agent/linux/22.07/admin-guide/features/collaboration/collaboration/
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Joining a Collaboration Session

The guest collaborator can join the PCoIP session once they have received the invite link and invite

code from the host collaborator. Invite links and codes are generated on the remote PCoIP agent

machine; for instructions, refer to the agent administrators' guides linked above.

1. Open a web browser and go to the invite link shared with you (you may be able to click this link

directly, depending on how it was shared with you).

2. The web browser will warn you that the link is attempting to open the PCoIP Client application.

Allow the browser to open the PCoIP Client.

3. When the PCoIP Client opens, it will prompt you for your name and the Collaboration Invitation

Code. The value you enter for your name is used to tell the host who is joining; the

Collaboration Invitation Code is the six digit number provided by the host. Enter both values

and click Submit.

4. Once the host collaborator accepts your connection request, the Collaboration screen share

will start.

5. To leave the collaboration session, select Connection > Disconnect from the PCoIP Client

menu.

Mouse Visibility

Collaboration Mouse Visibility allows the guest collaborator to see the host's mouse cursor

movements within a collaboration session. This feature is only available when both collaborators

are using a PCoIP client 22.07 or newer, and the PCoIP agent is also version 22.07 or later. 

Currently, mouse visibility only works in the default standard client mode. High performance client

mode does not support mouse visibility. See High Performance Client for instructions to enable or

disable high performance client mode.

Future releases will add the ability for the Guest Collaborator to take control of the session mouse

and keyboard. 

Joining a Collaboration Session
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Displays

The PCoIP Client supports a maximum of four displays and a maximum resolution of 4K UHD

(3840×2160).

Monitors can be arranged in a vertical line, a horizontal line, or as a 2×2 box display. They can be

used in any standard rotation (0°, 90°, 180°, or 270°), with any monitor as the primary display.

Note: Using multiple high-resolution displays

Systems with multiple high-resolution displays, such as quad 4K UHD topologies, require powerful system

infrastructure. Be sure to use a system with sufficient bandwidth and client capability to support your required display

topology.



Important: Attaching monitors to the host machine in not supported

PCoIP client supports a maximum of four displays. Attaching extra monitors to the host machine will conflict with

client display topologies.



Displays
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Supported Installer Languages

The PCoIP Client installer supports the following languages:

• French

• German

• Spanish

• Simplified Chinese

• Traditional Chinese

• Japanese

• Portuguese

• Italian

• Korean 

• Russian

• Turkish

Supported Installer Languages
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PCoIP Ultra

The PCoIP Client provides support for PCoIP Ultra, the latest protocol enhancements from

Teradici. PCoIP Ultra is optimized for truly lossless support with bit-exact color accuracy and

preservation of content detail at the highest frame rates.

PCoIP Ultra protocol enhancements propels our industry-recognized performance into the future

of remote computing, with faster, more interactive experience for users of remote workstations

working with high-resolution content.

PCoIP Ultra enhancements are controlled on the PCoIP Agent. There is no configuration required

on the PCoIP Client.

For additional detail on PCoIP Ultra technical requirements for various use cases and

troubleshooting steps, refer to KB 2109: PCoIP Ultra Troubleshooting.

When to Enable PCoIP Ultra

PCoIP Ultra is apporpriate for users with the following requirements:

Auto Offload: Achieves the best balance between color accuracy and network efficiency. This

setting is appropriate for work-from-home or WAN content creators who require optimized delivery

of high resolution content, including video playback, while still achieving build-to-lossless color

accuracy.

CPU Offload: Provides efficient scaling across multicore CPUs, leveraging AVX2 instruction sets.

Appropriate for users that require CPU-optimized delivery of 4K UHD, high-framerate video

playback and build-to-lossless color accuracy. It is also useful when GPU encoding resources must

be reserved for video encoding applications, typically in LAN environments.

PCoIP Ultra is appropriate for specific use cases

For most users, the default PCoIP protocol will provide the best possible experience. Carefully review the

recommended use cases in the next section to determine whether you should enable it.



PCoIP Ultra
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GPU optimization Offload: PCoIP encoding is always offloaded to a GPU. Appropriate for users

who demand the highest possible CPU efficiency.

For all other scenarios, Teradici recommends that you leave PCoIP Ultra disabled.

Requirements

To take advantage of PCoIP Ultra, you need:

• A PCoIP Agent (any type), 21.03 or later

• A PCoIP Software Client (any type), 21.03 or later

• The CPUs on both the agent and the client machines must support the AVX2 instruction set.

Enabling PCoIP Ultra

PCoIP Ultra is disabled by default, and must be enabled on the PCoIP agent. The method used to

do this varies by agent type; consult the following documentation for instructions:

• PCoIP Graphics Agent for Windows

• PCoIP Graphics Agent for macOS

• PCoIP Graphics Agent for Linux

• PCoIP Standard Agent for Windows

• PCoIP Standard Agent for Linux

Auto-Offload with PCoIP Ultra

When using a PCoIP graphics agent, PCoIP Ultra can automatically select and switch between

CPU-offload and GPU-offload modes based on the amount of pixel change in the displays. When

displays are rendering highly dynamic content, PCoIP Ultra will enable GPU Offload to provide

improved frame rates and bandwidth optimization. When displays are less dynamic, PCoIP Ultra

defaults to CPU offload to provide the best image fidelity.

PCoIP Ultra Offload only takes effect if the remote PCoIP graphics agent and the PCoIP software

client are capable of both CPU and GPU offload.

Requirements
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The PCoIP Ultra offload mode is set on the PCoIP agent; PCoIP Ultra Auto Offload requires a PCoIP

Graphics Agent. Refer to the appropriate documentation for instructions:

• PCoIP Graphics Agent for Windows

• PCoIP Graphics Agent for macOS

• PCoIP Graphics Agent for Linux

PCoIP Codec Indicator

When enabling PCoIP Ultra there will be an onscreen indicator at the bottom left corner of the

screen. PCoIP Ultra CPU optimization is indicated with a dark blue dot. PCoIP Ultra GPU

optimization is indicated by a magenta dot. 

To disable this codec indicator, create the following registry key and set it to 0: 

Computer\HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\Teradici\PCoIP\pcoip_admin_defaults\

pcoip.codec_indicator (DWORD)

PCoIP Codec Indicator
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Printing Support

The following are the printing options available with the PCoIP Client:

• Local USB Printing: Printing to a USB printer locally attached to the Client device.

• Remote Network Printing: Enables printing to a network printer on the nost machines

network. Not suitable in situations here the PCoIP Software Client device is not on the same

network as he host device.

• Cloud Printing: This is access to external Cloud Services that are set-up on your local

workstation and network. Once these services have been correctly configured they can be

used by the PCoIP Software Client.

• Local Network Printing: Enables printing from the host machine to a printer in the PCoIP

Client machine's local area network. This method is suitable for printing when host and client

are not on the same network or for identifying and printing to local printers that exist in multi-

site organizations.

Support for each of these methods varies depending on which PCoIP agent the Software Client for

Windows connects to. The Software Client for Windows printing support is as follows:

Windows agents Linux agents macOS agents

Local USB Printing — — —

Remote Network Printing  — —

Local Network Printing  — —

Cloud Printing  — —

Printing Support
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USB Support

PCoIP Clients supports redirecting USB devices to a remote session. Administrators can set rules

governing allowed and disallowed devices, device classes, or device protocols. 

Isochronous USB device support

Some USB devices with time-sensitive information, such as webcams, are supported when

connecting to the PCoIP Agent for Windows.

Additionally, Teradici's technology partners provide solutions to expand peripheral support. For

more information, look for partners listed under Peripherals on the Teradici Technology Partners

page.S

Important: USB support is enabled by default

USB bridging is enabled by default. If you want to restrict or disable USB support, you can globally disable or set rules

governing USB behavior via GPO settings on the PCoIP Agent.



USB Redirection

USB redirection is only intended to be used with a single instance of the PCoIP Software Client. Launching a second

instance of the PCoIP Software Client while USB devices are redirected from another client may not work as expected.



USB Support
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Console Game Controller Support

PCoIP Software Clients are compatible with the following console game controllers:

• PS4

• PS5

• Logitech F310 gamepad

The following console game controllers are supported with the PCoIP Zero Client:

• Xbox One 2015

• Xbox One

• Xbox One S

• Xbox One Bt

• Xbox One Elite

Console Game Controller Support
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Relative Mouse Support

Relative Mouse is a method of translating mouse movements as a delta from the last mouse

position rather than a move to an absolute position on the screen. This type of mouse control is

used in many CAD/CAM, Visual Effects and First-Person Gaming software. In a CAD program you

may want to control an objects orientation in 3-D with mouse movements. Moving the mouse to

the left or right rotates the object around the Z-axis, and moving the mouse up or down rotates the

object around the X-axis. As you continue to move the mouse left the object continues to rotate

about the axis, and the rotation is not bounded by the mouse stopping at the boarders of the

screen. 

In fact while in relative mouse mode, the mouse cursor is not visible as the position of the mouse

is not important, the mouse is only being used to control movements - up/down or left/right. 

Applications that use relative mouse movements generally provide methods for entering or exiting

relative mouse mode, for instance clicking on an object with the middle button. While the middle

button is held down the object may be controlled using relative mouse movements.

This feature is currently supported with the following components:

The following components do not support this feature:

• PCoIP Standard Agent for Linux

Relative Mouse Support Supported

PCoIP Software Client for Windows 

PCoIP Software Client for Linux 

PCoIP Software Client for macOS 

PCoIP Tera2 Zero Client 6.4 (Requires Configuration to enable) 

PCoIP Standard Agent for Windows 

PCoIP Graphics Agent for Windows 

Relative Mouse Support
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• PCoIP Graphics Agent for Linux 

• PCoIP Graphics Agent for macOS

• PCoIP Software Clients in High Performance Mode

Enabling Relative Mouse

The following sections outline how to enable relative mouse support on the PCoIP Software Client

for Linux.

Enabling from the Menu Tab

The following steps outline how to enable relative mouse from the menu tab, while connected to a

supported PCoIP Agent with a supported PCoIP Client:

1. Click Connection from the menu tab.

2. Select the Relative Mouse option and click it to enable it. Once the check-mark is visible

beside the Relative Mouse option it is enabled. 

If you are connected to a PCoIP Agent version that does not support relative mouse then you will

not be able to select this option.

Enabling with a Hot-Key

To enable relative mouse using a hot-key, while connected to a supported PCoIP Agent with a

supported PCoIP Client, press ctrl + alt + r . This will toggle the feature on and off. This will

only work if you are connected to a PCoIP Agent version that supports relative mouse.

Enabling Relative Mouse
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SpeechMike Support

SpeechMike is supported between the PCoIP software client for Windows and a PCoIP agent for

Windows.

SpeechMike is an isochronous USB device, and requires USB ISO device support to be enabled.

The HID checkmark needs to be selected for the feature to work.

On the Windows VM agents set pcoip.enable_unsupported_iso_devices=1, using the command

line below:

On the PCoIP Client machine, set pcoip.usb_allow_unsupported_device=1 using the command

line below:

REG ADD HKLM\Software\Policies\Teradici\PCoIP\pcoip_admin_defaults /v 
pcoip.enable_unsupported_iso_devices /t REG_DWORD /d 1

REG ADD HKLM\Software\Policies\Teradici\PCoIP\pcoip_admin_defaults /v 
pcoip.usb_allow_unsupported_device /t REG_DWORD /d 1

SpeechMike Support
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Wacom Tablet Support

The Software Client for Windows supports Wacom tablets in two configurations: bridged, where

peripheral data is sent to the desktop for processing, and locally terminated, where peripheral data

is processed locally at the Software Client.

Locally-Terminated Wacom Tablets

Locally terminated Wacom tablets are much more responsive, and tolerate high-latency

connections better than bridged. 

Local Termination is automatically used whenever it is supported for a device. If you prefer to use

bridged mode—if, for example, you must use sophisticated tablet features like touch, which is not

supported by local termination—you can override this behavior by blacklisting a device for local

termination.

Local termination requires a supported PCoIP agent (any type), and a supported Software Client

for Windows.

PCoIP client support for locally terminated Wacom tablets and the Software Client for Windows

PCoIP

Standard

Agent for

Linux

PCoIP

Graphics

Agent for

Linux

PCoIP

Standard

Agent for

Windows

PCoIP

Graphics

Agent for

Windows

PCoIP Remote

Workstation

Card

Intuos Pro Small

PTH-460

    —

Intuos Pro Medium

PTH-660

    —

Intuos Pro Large

PTH-860

    —

Cintiq 22HD

DTK-2200

    —

Wacom Tablet Support
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Bridged Wacom Tablets

Bridged Wacom tablets should be used only in low-latency environments. Tablets that are bridged

in network environments with high latency (greater than 25ms) will appear sluggish and difficult to

use for artists, and are not recommended.

When connecting a Wacom tablet, bridged mode is used only if local termination is not available.

To override this behavior, causing the Software Client for Windows to use bridged mode instead,

add the device to the Local Termination Blacklist.

PCoIP

Standard

Agent for

Linux

PCoIP

Graphics

Agent for

Linux

PCoIP

Standard

Agent for

Windows

PCoIP

Graphics

Agent for

Windows

PCoIP Remote

Workstation

Card

Cintiq Pro 24 -

 Pen Only

DTK-2420

    —

Cintiq 22

DTK-2260

    —

Cintiq 22HDT -

 Pen & Touch

DTH-2200

— — — — —

Cintiq Pro 24 -

 Pen & Touch

DTH-2420

    —

Cintiq Pro 32 -

 Pen & Touch

DTH3220

    —

Note: Graphics Agent for macOS does not support bridged Wacom tablets

The Graphics Agent for macOS only supports local termination of Wacom devices. 



Bridged Wacom Tablets

© 2021 Teradici 20



The following Wacom tablet models have been tested and are supported on the Software Client

for Windows:

PCoIP client support for bridged Wacom tablets and the Software Client for Windows

PCoIP

Standard

Agent for

Linux

PCoIP

Graphics

Agent for

Linux

PCoIP

Standard

Agent for

Windows

PCoIP

Graphics

Agent for

Windows

PCoIP Remote

Workstation

Card

Intuos Pro Small

PTH-460

    —

Intuos Pro Medium

PTH-660

    —

Intuos Pro Large

PTH-860

    —

Cintiq 22HD

DTK-2200

    —

Cintiq Pro 24 -

 Pen Only

DTK-2420

    —

Cintiq 22HDT -

 Pen & Touch

DTH-2200

    —

Cintiq Pro 24 -

 Pen & Touch

DTH-2420

    —

Cintiq Pro 32 -

 Pen & Touch

DTH3220

    —

Bridged Wacom Tablets
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Connecting Cintiq Pro 32 Tablets

The Wacom Cintiq Pro 32 appears as three separate devices in the USB menu. You should

connect the following USB devices to use this tablet:

• ExpressKey Remote

• Cintiq Pro 32 Touch

• Wacom Cintiq Pro 32

Known Issues

The following limitations apply to Wacom tablet support:

• Touch only works on the Cintiq Pro 32 Pen & Touch (DTH-2420). Touch functionality is not

supported for any other Wacom tablet.

Connecting Cintiq Pro 32 Tablets
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• ExpressKey Remote does not work on the Wacom Cintiq Pro 32 (DTH-3220). You should still

connect this device when connecting the Wacom tablet.

• There are cursor limitations when working with the Wacom Cintiq 22HD (DTK-2200) and

Wacom Cintiq Pro 24 (DTK-2420) for both bridged and locally terminated devices.

• Control buttons on the Wacom Cintiq Pro 32 (DTH-3220) do not function when locally

terminated.

• PCoIP Clients are not compatible with NoMachine and No Machine USB drivers. For

information on how to uninstall NoMachine USB drivers, see No Machine's knowledge base.

Known Issues
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Webcam Support

The Software Client for Windows now supports USB webcams when connecting to a PCoIP Agent

for Windows. USB webcams can now be used while in the remote desktop, including with

applications such as Microsoft Teams or Zoom.

For detailed information which models have been tested and the performance metrics associated

with these models see here. This knowledge base article also deals steps on how to test and verify

other webcam models.

This feature is enabled by default.

Requirements

Webcam support requires the following:

• Software Client for Windows, 21.07+

• PCoIP Standard Agent for Windows or PCoIP Graphics Agent for Windows, 21.03+

• USB-attached webcam.

Notes and Limitations

• Webcams must be connected via USB. Webcams that are not USB, such as embedded laptop

webcams, are not supported.

• Linux agents are not supported.

• PCoIP Software Client for macOS is not supported.

• If the browser on the remote desktop terminates when a webcam is connected, you must

disable the webUSB setting in Chrome by running the following command in the search bar of

the Chrome browser: 

Open the Chrome menu and disable the webUSB flag.

chrome://flags/#enable-webusb-device-detection

Webcam Support
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Setup

On the PCoIP Software Client, connect the webcam as described in USB Bridging of Webcams.

Setup
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Installing the Software Client for Windows

In this section, you will learn how to install and uninstall the Software Client for Windows for

Windows.

Before You Begin

Before installing the Software Client for Windows:

• You must be logged in as an administrator to the client machine.

• Close any existing Software Client for Windows applications.

Installing the Software Client

You can install the Software Client for Windows with the provided Windows installation wizard or

from the command line.

To install the Software Client for Windows using the wizard:

1. Double-click the Software Client for Windows installer executable (pcoip-client.exe) to begin

installation.

2. Follow the prompts to specify installation locations, and to agree to any licenses.

3. Click Finish to complete installation and close the installer.

To install the Software Client for Windows silently from the command line:

• Install the Software Client for Windows silently by running the installer executable from the

command line:

Microsoft Visual C++ Redistributable package

The libraries in this package are required by the Software Client for Windows. If they aren't already installed, a

wizard will launch and install them for you.


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where  is the full path to the folder containing the pcoip-client.exe

executable.

Uninstalling the Software Client

To uninstall the Software Client for Windows:

1. Click Start (or Search Windows for Windows 10).

2. In the search box, type Add or remove programs and press Enter.

3. Select Teradici PCoIP Client from the list of programs.

4. Click the Uninstall/Change button above the list.

Installing the Software Client in Silent Mode

The following section outlines how to install the PCoIP Software Client in silent mode. Please note

that you must authorize the application to run in silent mode. To install the PCoIP Software Client

on Windows use the  switch on the command line when launching the installer in the Windows

CMD Prompt as outlined in the following example:

<path-to-installer>\pcoip-client.exe /S`

<path-to-installer>

Silent installation uses default options

The silent installer uses default settings and options. For example, a silent installation won't create a desktop

shortcut.



Troubleshooting PCoIP Session Connection Issues

If you encounter issues with your PCoIP Session, please see the following KB article: https://help.teradici.com/s/

article/1027. This article details some potential causes and fixes for common connection issues. 



/S

C:\Downloads\pcoip-client_21.03.0.exe /S
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Connecting to an Anyware Desktop

You can connect to remote Windows, macOS, or Linux hosts with a PCoIP agent installed.

Connections can be made directly from the PCoIP client machine to the PCoIP agent machine, or

via a connection manager in enterprise deployments.

The connection process is the same in either case.

To connect to a remote Anyware desktop:

1. Launch the Software Client for Windows application.

2. In the Host Address or Code field, provide the address you will connect to. It will be one of the

following:

• For direct connections, where you are connecting directly to the remote machine, provide

the address of the remote machine itself.

• For managed connections, where a connection manager is used, provide the address of

the connection manager. In this scenario, the connection manager handles the

connection to the desktop.

The address can be an IP address or a FQDN (fully-qualified domain name).

3. Click NEXT.

Tip: Saved connections

If you want to save this connection for use later, provide a name for it in the Connection Name field. You will

have the option to save the connection later.



Connecting to an Anyware Desktop

© 2021 Teradici 28



4. Provide your login credentials:

a. Select your domain from the dropdown list on the left side (it will be pre-selected if there

is only one available)

b. Enter your credentials in the username and password fields.

• For direct connections, these will be the credentials for your user account on the

remote machine.

• For managed connections, these will be your corporate credentials.

c. Click LOGIN.

5. Next, complete the connection:

• Single desktop users: If you have only a single available desktop, the client will connect to

it automatically. You will not see the screen shown next.

• Multiple desktop users: If you have multiple desktops available, a screen like this one will

list them for you:

About the Security Padlock Indicator

The login screen displays a red padlock indicator when accessing a PCoIP agent desktop that uses default self-

signed certificates. The icon indicates that the software’s certificate is not signed by a trusted certificate

authority (CA).

You can use your own CA to create a certificate and then install the appropriate files at each end. If the client

trusts your internal CA, a green padlock icon displays on the screen instead. 


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Click on the desired desktop to select it, then click Connect.

Tip: Saving connections

If you provided a connection name in step 1, you will have the option to save the connection 



Note: A short delay in responsiveness is normal

When a session is first connected, it may take a few seconds before you have control of the keyboard and mouse. 


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Connecting to Amazon Workspaces

Connections to Amazon Workspaces desktops can use either Active Directory or an existing

Radius server to provide multi-factor authentication (MFA).

Connecting to an Amazon Workspaces desktop:

1. Launch the Software Client for Windows application.

2. In the Host Address or Code field, enter your Amazon Workspaces registration code:

 

If you want to save this connection, enter a name in the Connection Name field here.

3. Click NEXT.

Connecting to Amazon Workspaces
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4. On the next screen, enter your Amazon Workspaces username, Password and MFA token and

then click OK. 

If your credentials are accepted, the PCoIP connection is established and your desktop appears.

About the Security Padlock Indicator

The login screen displays a red padlock indicator when accessing a PCoIP agent desktop that uses default self-signed

certificates. The icon indicates that the software’s certificate is not signed by a trusted certificate authority (CA). You

can use your own CA to create a certificate and then install the appropriate files at each end. If the client trusts your

internal CA, a green padlock icon displays on the screen instead. To learn more about certificates, see the PCoIP

agent administrators guides listed in the Teradici Cloud Access Architecture Guide.



Interface Delay

When a session is first connected, it may take a few seconds before you can take control of the keyboard and mouse.

This is normal behavior.


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Connecting to PCoIP Remote Workstation Cards

You can connect to remote workstations equipped with a PCoIP Remote Workstation Card, and

with PCoIP Remote Workstation Card Software (for Windows or Linux) installed. 

Refer to System Requirements for supported versions.

Initial Workstation Configuration

Before you can connect to your remote workstation for the first time, you must install software

and make some configuration changes. These actions only need to be taken once for each remote

workstation in your system:

• Record the MAC address of the PCoIP Remote Workstation Card

Before you install the PCoIP Remote Workstation Card, record the MAC address of the PCoIP

Remote Workstation Card; this will allow you to log into the card to configure its settings. Type

 where  is the MAC address

of your PCoIP Remote Workstation Card and mydomain is the local domain of your network.

This step is important as the host driver function is disabled by default, so the Remote

Workstation Card Software will not pick up information about the PCoIP Remote Workstation

Card, such as the MAC address. The MAC address enables you to connect to the PCoIP

Remote Workstation Card to view the IP address and enable the host driver function. 

For more information on IP and MAC information relating to the PCoIP Remote Workstation

Card, see How do I find the IP address of my newly installed PCoIP Zero Client or PCoIP

Remote Workstation card? in the knowledge base.

• Install PCoIP Remote Workstation Card Agent

To connect to a remote workstation with a PCoIP Remote Workstation Card using a PCoIP

Software Client, the Remote Workstation Card Agent must be installed.

• Enable monitor emulation for the video ports on your remote workstation

If monitor emulation is not enabled, you may see blank gray screens when you connect from

the PCoIP Software Client.

https://pcoip-host-<MAC_ADDRESS>.mydomain <MAC_ADDRESS>
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To enable monitor emulation, log in to the card’s Administrator Web Interface (AWI) and select

Enable Monitor Emulation on Video Port n from the Configuration > Monitor Emulation menu.

For more information, see the PCoIP Remote Workstation Card Administrators' Guide.

• Disable temporal dithering

Temporal dithering causes blurriness, heavy packet loss, and high CPU usage on the PCoIP

Software Client machine.

• Linux workstations: configure PCoIP Remote Workstation Card Software to Start

Automatically

To configure the PCoIP Remote Workstation Card Software to start automatically, log into the

workstation using a PCoIP Zero Client or directly from a local mouse and keyboard, and

modify the workstation startup script to launch the PCoIP Remote Workstation Card Software.

For details, see Installing PCoIP Remote Workstation Card Software Binary RPM in the 

PCoIP® Remote Workstation Card Software for Linux User Guide.

Connecting to a Remote Workstation Card

Once the remote workstation is properly configured, you can connect to it from the PCoIP

Software Client.

Connecting to a Remote Workstation Card via a PCoIP Software Client

The direct connection from the PCoIP Software Client to the PCoIP Remote Workstation Card is

supported through the PCoIP Remote Workstaton Agent software which needs to be installed on

the workstation where the PCoIP Remote Workstation Card is installed. You must have a Remote

Workstation Card Agent installed to enable a connection to a Remote Workstation Card.

Both the NIC of the workstation and the NIC of the PCoIP Remote Workstation card need to be

accessible by the PCoIP Software Client. They can be on different local networks as long as both

are accessible by the PCoIP Software Client. If they are both behind a NAT and accessed by the

Workstation configuration is required before connecting

If you experience connection problems or degraded performance, make sure that the workstation is configured as

described in Initial Workstation Configuration.


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PCoIP Software Client then the PCoIP Remote Workstation Card Agent must send the NAT'ed

address to the PCoIP Software Client when connecting.

Connecting to a PCoIP Remote Workstation Card through the command line

You can have a direct connection to a PCoIP Remote Workstation card, from a PCoIP Software

Client, without requiring a PCoIP Remote Workstation Card agent installed on the host machine if

you connect via the command line by using the  option with the IP address of your

PCoIP Remote Workstation Card, for example:

10.11.12.13 is the IP address of the PCoIP Remote Workstation Card.

Connecting to a remote workstation with a Teradici PCoIP Remote Workstation

Card installed:

1. Double-click the PCoIP Client desktop icon, alias, or program file (PCoIPClient) to launch the

application.

Anyware Subscription

You need to have a valid Anyware Subscription to use the PCoIP Remote Workstation Card Agent.



Direct Connection to PCoIP Remote Workstation Cards

PCoIP brokering can now be used to connect to the Remote Workstation Card. You can still connect to a non-

brokered Remote Workstation Card by connecting to the FQDN of the workstation instead of the FQDN of the Remote

Workstation Card. This method of connection requires the Remote Workstation Card Agent to be installed on the

workstation



--hard-host

pcoip_client.exe --hard-host 10.11.12.13
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2. In the Host Address and Code box, enter the fully-qualified computer name or IP address of

the remote workstation or the address of the PCoIP broker; this can be Cloud Access Manager

or a third-party broker.

3. Optional: In the Connection Name box, enter a name for your connection. This field accepts

any Unicode character.

4. Click NEXT.

5. If your desktop is locked upon connection and requires you to enter Ctrl+Alt+Delete to log in,

select Connection > Send CTRL-ALT-DEL from the PCoIP Software Client menu bar.

PCoIP Remote Workstation Card Feature Compatibility

Not all features with the Software Client are fully supported when connecting to a PCoIP Remote

Workstation Card. The following section outlines these limitations against certain features.

The Connection Information can be saved

If you provide a connection name now, you will have the option of saving the connection after you are

authenticated. Saved connections can be quickly recalled later, without manually re-entering connection

information.



A short interface delay is normal

When a session is first connected, it may take a few seconds before you can take control of the keyboard and

mouse. This is normal behavior.


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Audio: PCoIP Remote Workstation Card uses a hardware based audio protocol which is not fully

supported on the Software Client.

Topology: Single display configuration will work. There may be disruptions in the forms of black

bars or scroll bars on the client if the PCoIP Remote Workstation Card does not support the

display configuration on the client. The worst instance of this disruption will occur for some client

configurations that don't work with the hard host configuration.

USB: Connecting USB devices to the PCoIP Remote Workstation Card is not supported.

Performance: Updated to support PCoIP Ultra are not applicable to the RWC.

Connecting Remotely using NAT or VPN

The same principles that apply for PCoIP Zero Clients apply to PCoIP Software Clients when

connecting to multiple hosts through a WAN. Connections from a PCoIP Software Client to a

Remote Workstation Card across a WAN will require a VPN or NAT setup with enterprise level

NATing devices. For information on how to connect a PCoIP Software Client to a Remote

Workstation Card installed in a Windows host computer, see Conections from Software Clients in

the PCoIP Remote Workstation Card Administrators' Guide.

Connecting Remotely using NAT or VPN
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Disconnecting a Session

To disconnect a PCoIP session:

1. If you are in a full-screen mode, reveal the Software Client for Windows menu bar by moving

the mouse cursor to the top of a display.

2. From the Software Client for Windows menu bar, select Connection > Disconnect.

Quitting the PCoIP Client application will also disconnect the current session.

Tip: Quickly disconnect from a session

To quickly disconnect from a session, press Ctrl + Alt + F12 .


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Using Saved Connections

Once you have saved a connection, you can use it to reconnect quickly.

To reconnect using your saved connection:

1. Launch the Software Client for Windows.

2. If you have saved connections previously, you will see them displayed now. The names shown

here are the connection names you provided.

Click the connection you need; you will proceed immediately to the authentication screen and

then to the requested desktop.

To edit or delete a saved connection

To edit or delete a saved connection, click its gear icon (found on the right end of the connection

button) and choose the desired action from the dropdown menu.

Tip: Filtering results

If you have a large number of saved connections, you can filter the connections shown by typing keywords in the

search bar at the top of the window.



Tip: Revealing saved connection URLs

If you must see the connection URL associated with any of the saved connections, hover your mouse pointer

over it. The URL will be shown in a tooltip.


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Advanced Saved Connections

Administrators can save more complex desktop connections with the PCoIP Client. The following

section outlines the connection scenarios that can be saved, and outlines the potential benefits of

doing so.

Saved Broker Address

This configuration enables you to create a saved connection where only the broker address is

saved. You need to enter your username when connecting to a remote host. Enter the host

address and name the connection, then click SAVE.

For more information on system components and connections using a broker, see About PCoIP

Sessions section in the Windows Client SDK guide.

Pre-configured connections

This partial save feature enables administrators to pre-configure connection information as a saved connection and

bundle it with the client application. For example, administrators can save a connection with the FQDN of the PCoIP

Connection Manager preset and then distribute this information to their deployed clients. As a result of this users

would be able to skip past the initial domain screen and advance directly to their user authentication screen.

The administrator can find and distribute the connection info file located at %APPDATA%\Teradici\PCoIP Client 

Connection Info.ini


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Multiple Desktops

This configuration enables you to see and access a selection of desktop environments each time

you connect. 

1. Enter the host address and name the connection 

2. Enter and save the Username 

Multiple Desktops
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Once you have done this each time you use this connection you will be presented with the list of

available desktops for that connection. 

Multiple Desktops
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Using Displays

When you connect to a PCoIP session, the Software Client for Windows shows your remote

desktop as one or more displays. The number of displays it shows is constrained by your local

system's available monitors (and the PCoIP protocol itself, which supports up to four monitors).

You can choose whether the Software Client for Windows shows your remote session as a single

display in a resizable window, or as one or many full-screen displays. 

You can also add or remove local displays during a session.

Display Modes

Using the Software Client for Windows, you can switch between three display modes. Note that

some of these modes are system-dependent; for example, if your local system has only one

monitor, you will not see options for multiple displays.

• Windowed mode: A single display shown in a window.

• Full Screen All Monitors: All available local monitors are used in full-screen mode to show the

remote desktop.

• Full Screen One Monitor: A single display shown full-screen on the local system.

Windowed Mode

In Windowed mode, the Software Client for Windows provides a single window, resizable and

movable, which contains the remote desktop. The remote desktop will rescale to fit your window

dimensions if you change them.

To use windowed mode:

1. Reveal the Software Client for Windows menu bar by moving the mouse cursor to the top of a

display.

2. From the Software Client for Windows menu bar, select View > Leave Fullscreen.

Using Displays
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Full Screen Modes

In full-screen modes, the Software Client for Windows expands to fill either one local display or all

of your local displays.

In both full-screen modes, the Software Client for Windows menu bar is hidden. To reveal it, move

your mouse cursor to the top of the display and hover for a moment.

Full Screen All Monitors

In full screen all monitors mode, the application expands to present full-screen remote displays on 

all of your local monitors. The remote desktop will map a remote display to each of your local

displays.

You will only see this option if your local system has multiple displays.

To use Full Screen All Monitors mode:

1. If you are in full-screen one monitor mode, reveal the Software Client for Windows menu bar

by moving the mouse cursor to the top of a display.

2. From the Software Client for Windows menu bar, select View > Fullscreen All Monitors.

Full Screen One Monitor

In full screen one monitor mode, the presents a single full-screen remote display on one of your

monitors. 

If you switch from Full Screen All Monitors to Full Screen One Monitor, all open windows and

applications will be moved onto the single display. 

Tip: Quickly switch to full-screen mode

You can quickly switch from windowed mode to whichever full-screen mode you used last by pressing 

ctrl + alt + Enter . 


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To use Full Screen One Monitor mode:

1. If you are in a full-screen mode already, reveal the Software Client for Windows menu bar by

moving the mouse cursor to the top of a display.

2. From the Software Client for Windows menu bar, select View > Fullscreen One Monitor.

Adding or Removing Displays

You can add or remove local displays during a PCoIP session. If you are using full screen all

monitors mode, you must detect the changes before they will be effective. Note that in the case of

removing monitors, this could mean that some applications or information is inaccessible until the

detect monitors command is issued.

Detecting Monitors

If the local display configuration changes during a session—for example, if you attach a new local

monitor, or disconnect an old one—the display mapping between the local and remote

topographies is no longer accurate,leading to unpredictable display behavior. You must be refresh

the display mapping to accurately show the new configuration.

To synchronize local display changes:

1. If you are in a full-screen mode already, reveal the Software Client for Windows menu bar by

moving the mouse cursor to the top of a display.

Tip: Monitor selection

The local monitor chosen for full-screen display depends on the mode you are switching from:

• If switching from windowed mode, the client's current display becomes full-screen.

• If switching from full screen all monitors mode, the display used to select fullscreen one monitor mode becomes

full-screen.



Note: Systems with only one display

If your local machine has only one display, the menu option will say Show Fullscreen.


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2. From the Software Client for Windows menu bar, select View > Detect Monitors.

The local display configuration will synchronized with the remote. The local displays may flicker or

go black momentarily while the remote system updates its display topography.

Detecting Monitors
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Connecting USB Devices

Remote desktops can use USB devices that are attached to the client, using a process called 

redirection. USB devices are not automatically redirected to the remote desktop; they must be

specifically connected to the session. 

Important considerations

• USB functionality depends on PCoIP Agent configuration: The remote PCoIP agent must be

configured to allow USB redirection. If it is not, only HID devices like keyboards and mice will

be used, and the Connection > USB Devices option will not be visible in the Software Client for

Windows menu bar.

• Local Termination and Bridging: Most USB devices are bridged to the host, which means their

input is sent directly to the host machine for processing. Certain devices, including ePadLink

Signature Pads and some Wacom tablets, connect using a different method called local

termination. This mode does some pre-processing of device information locally at the client

before forwarding to the host, resulting in increased responsiveness and better tolerance of

high-latency networks. 

The mode chosen is automatic, unless overridden. See Wacom Tablets for information about

which Wacom tablets are supported.

• Persistence: USB device connections do not persist across multiple PCoIP sessions. You

must connect your USB device each time you connect.

• NoMachine USB Drivers: PCoIP Clients are not compatible with NoMachine and No Machine

USB drivers. For information on how to uninstall NoMachine USB drivers, see NoMachine's

knowledge base.

Note: Excludes Mice and Keyboards

Normal Human Interface Devices (HID), such as keyboards and mice, are always connected and used by the remote

desktop. This page describes using non-HID USB devices such as tablets or cameras.


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Connect a USB Device

To Connect a USB device:

1. Attach the USB device you want to connect to your local machine.

2. Select Connection > USB Devices from the PCoIP Software Client menu.

A list of all USB devices connected to your client machine appears. The list includes both

external devices you plug in and integrated devices such as laptop cameras.

The name shown in the list is self-reported by the device; some devices will identify

themselves only as USB Device.

3. Click Connect beside the USB device you want to use.

Important: Connecting special HID devices

Because most Human Interface Devices (HIDs) are automatically processed by the Software Client for Windows,

they do not appear on this list even if they use a USB connection. However, certain HID devices—like 3D mice

and Wacom tablets—actually do require processing on the remote host, and will not work as expected unless

connected to the session.

To show these hidden HID devices and allow them to be connected, enable the Show Human Interface Devices

checbox. You may also need to perform additional configuration steps or install drivers on the remote machine.


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Disconnect a USB Device

1. Select Connection > USB Devices from the PCoIP Software Client menu.

Disconnect a USB Device
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2. Click Disconnect beside the USB device you want to disconnect. 

Automatically Forward All USB Devices

Automatic forwarding allows you to bridge all non-HID USB devices without requiring a manual

connection step.

To enable automatic forwarding, launch the client using either the command-line or URI methods

and use the  flag. For more information, see USB Auto-Forward in the

Configuration section.

Note: Auto-forwarded devices can be disconnected from the client

Devices that are automatically forwarded can still be disconnected and reconnected via the Software Client for

Windows interface.



usb-auto-forward
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Automatically Forward Devices by Vendor ID/Product ID

You can automatically forward specific devices to the remote host without requiring a manual

connection step (devices not specified can still be connected manually, as shown above). 

Devices are identified by their Vendor ID and Product ID (VID and PID, respectively) which together

make a unique identifier. You can specify up to 20 devices to automatically connect using this

method. If more than 20 devices are provided, only the first 20 will be accepted. The rest will be

ignored, and noted in logs.

Invalid VID/PID pairs are discarded, and noted in logs.

To enable automatic forwarding by Vendor ID and Product ID, launch the client using either the

command-line or URI methods and use the  setting, providing the VID/PID

pairs for the devices you want to connect. For more information, usage, and examples, see Vidpid

Auto-Forward in the Configuration section.

Identifying Vendor and Product IDs

If you do not know the Vendor ID and Product ID of the device you want to automatically forward,

you can discover them using the client logs.

To discover the Vendor and Product IDs:

1. Unplug all USB devices.

2. Launch the Software Client for Windows.

3. Plug in the device.

4. Close the Software Client for Windows.

5. Find the most recent PCoIP Client log file.

Note: Auto-forwarded devices can be disconnected from the client

Devices that are automatically forwarded can still be disconnected and reconnected via the Software Client for

Windows interface.



vidpid-auto-forward
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6. In a log viewer or text editor, look for lines containing , and . In this

example, there are two entries with ; we want the first line, which also

contains the  and  assignments: 

7. VID and PID assignments appear like this: . The VID

and PID values we need are the strings after . 

Continuing the example,  means the VID we want is , and the

PID is .

8. The VID/PID pair is expressed as . Following our example, this device would be

specified as .

9. Provide this (and others, if applicable) VID/PID pair to Vidpid Auto-Forward when launching via

command line or URI, as indicated above.

Connect USB Webcams

USB Webcams may be used in remote sessions by connecting them to a Windows remote session

as USB devices. This feature has been tested with a limited number of popular webcams, including

the Logitech C920. See PCoIP Cloud Access Software Webcam Support for a current list of tested

webcams.

This feature is only supported by the Graphics Agent for Windows and the Standard Agent for

Windows, and is limited to resolutions of 480p or lower.

MGMT_USB :Device VID=

MGMT_USB :Device

VID PID

2040-12-12T20:36:46.117Z e0f9e9e9e-866f-1038-test-ac87a3007abc LVL:2 RC:   
0        MGMT_USB :Device 0x00010001 VID=0x18a5PID=0x0302
2040-12-12T20:36:46.117Z e0f9e9e9e-866f-1038-test-ac87a3007abc LVL:2 RC:   
0        MGMT_USB :Device 0x00010001 Name=TEST Serial=012345ABCDE 
pp=000222222

VID=0x<VID_VALUE>PID=0x<PID_VALUE>

0x

VID=0x18a5PID=0x0302 18a5

0302

<VID>,<PID>

18a5,0302
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Configure Wacom Devices

This section outlines how to configure your Wacom tablet through the PCoIP Client session. There

are two available features within the PCoIP Client that can be used to configure the monitor

display and orientation. This only applies to locally terminated Wacom Tablets. 

Wacom Tablet Monitor

The Wacom Tablet Monitor feature enables you to select the monitor you want to use with your

Wacom tablet. You can change between using a pen or mouse and select the orientation position.

To configure Tablet Monitor settings:

1. Select View from the in-session options bar.

2. Check the Tablet Monitor option.

3. Open Wacom Tablet Properties from the Wacom Desktop Center.

4. Select your device, tool and application.

5. Select your screen area from the dropdown menu.

USB Connection Instructions

Before you carry out the Wacom tablet monitor configurations below, you must connect to the device by following the

instructions outlined in the Connecting to USB Devices section.


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Tablet Orientation Left-handed

The left-handed orientation configures the tablet for a left-handed orientation. Select ExpressKeys

Right for a left-handed orientation, and ExpressKeys Left for a right-handed orientation. Rotate the

tablet to the desired orientation.

To configure Tablet Orientation:

1. Select View from the in-session options bar.

2. Check the Tablet Orientation Left-handed option.

3. Open Wacom Tablet Properties from the Wacom Desktop Center.

4. Select your device, tool and application.

5. Select your orientation from the dropdown menu.

Tablet Orientation Left-handed
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Reset Virtual Desktop

The following section outlines how to reset a saved desktop in the PCoIP Client. You can reset to a

virtual desktop by following the steps outlined below:

1. Click the configure button and select Edit from the popup menu. 

2. Click NEXT on the initial saved connection screen. 

Reset Virtual Desktop
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3. Enter your access credentials and click SAVE. 

4. Click the configure button and select Reset. If the Reset option is not available, then this

feature is not supported by the Connection Manager. 

Reset Virtual Desktop
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Enhanced Audio and Video Synchronization

Enhanced Audio and Video Synchronization (A/V Sync) provides improved full-screen video

playback, reducing the difference in delays between the audio and video channels and smoothing

frame playback on the client. This improves lip sync and reduces video frame drops for video

playback.

This feature introduces a small lag in user interaction responsiveness when enabled. Using

enhanced audio and video synchronization will reduce the maximum frame rate.

Enhanced A/V Sync is enabled on a per-display basis, so you can dedicate individual displays to

playback without impacting responsiveness on the others.

To use enhanced A/V Sync:

1. If you are in full-screen mode, reveal the menu bar on the display you want to enhance by

moving the mouse cursor to the top of the screen.

2. On the display you want to enhance select View>Enhanced A/V Sync to toggle the enhanced

sync mode.

Persistent Display Topology

The Enhanced Audio and Video Synchronization feature is persistent across sessions from the same client, provided

that the display topology has not changed.


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Sending a Ctrl-Alt-Del Command

To send the Ctrl-Alt-Del keyboard command to a remote workstation, select the Connection >

Send CTRL-ALT-DEL menu option.

Sending a Ctrl-Alt-Del Command
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Changing the Language

In addition to English, the PCoIP Software Client also supports these languages: Chinese

(Simplified), French, German, Italian, Japanese, Korean, Portuguese (Brazil), Portuguese (Europe),

Russian, Spanish, and Turkish. During installation, you can select one of the supported languages.

To change the language after installation:

In Control Panel > Region and Language > Formats tab, select another language in the Format list.

To change the language on the command line

Alternatively, the language can be set with the  parameter on the command line:

The following table lists the available language translations and codes:

locale

pcoip-client --locale <locale-code>

Language Code

German de

Spanish es

French fr

Italian it

Japanese ja

Korean ko

Portuguese (EU) pt

Portuguese (Brazil) pt_BR

Russian ru

Changing the Language
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Language Code

Turkish tr

Chinese (Simplified) zh_CN

Chinese (Traditional) zh_TW

Changing the Language
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Configuring the PCoIP Software Client for Windows

The Software Client for Windows provides a number of configurable settings and behaviors, which

allow the setting of user options, performance modes, and triggering actions like automated

connections. These settings are not persistent and cannot be set via the user interface; they are

set by launching the application using one of the methods described next.

To configure a client instance, you must launch it using one of these methods:

• On the command line, with configuration values passed inline as flags, or

• Via a URI, providing your configuration values in an encoded JWT string.

Setting Configuration Values on the Command Line

To set configuration values this way, launch the Software Client for Windows from a command

prompt, and include the required options as flags. Multiple flags can be included in the same line.

Use the following conventions when setting these parameters:

The following example launches the client in full-screen mode, sets log level 3, and points to a

connection broker at  (if your application is installed somewhere else, use

your own path instead):

The available settings are shown below.

Type Format

Boolean No value is required; the flag implies "True"

Numeric Provide the parameter and then the numeric value, separated by a space.

String Provide the parameter and then the string value, separated by a space. 

Values can be wrapped in double quotation marks if they contain spaces.

broker.domain.com

"c:\Program Files (x86)\Teradici\PCoIP Client\bin\pcoip_client.exe"  --
connection-broker  broker.domain.com  --log-level 3 --full-screen

Configuring the PCoIP Software Client for Windows
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Setting Configuration Values via a URI

Using this method, the Software Client for Windows is launched using a URI with configuration

options (and, optionally, connection credentials) encoded in a JWT token string.

To use this method, create a URI with the following structure:

Where each segment shown above is:

The JWT payload can contain both credential information and client configuration. To create the

JWT payload:

1. Create your configuration and credentials as a JSON object, using available configuration

parameters and authentication credentials.

2. Encode the object as a JWT token.

3. Pass the token through the URI as the  parameter.

For example, the following JSON object would launch the client in full-screen mode, with log level

3:

pcoip://[broker]/connect[?data={jwt}]

Segment Description

pcoip:// Required. This scheme is registered with the operating system and will launch the Software

Client for Windows.

broker Optional. FQDN of the connection broker to use. If the connection is not brokered, this can be

omitted.

/connect Required. Requests a connection with the parameters defined in "?data"

?

data={jwt}

Optional. The string indicated by {jwt} here is a JWT payload, containing any required

configuration settings and connection credentials. If all you want to do is launch the client with

no options set, this can be omitted.

data

Setting Configuration Values via a URI
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Encoded, and pointing to a connection broker at , this would result in a URI

similar to the following:

The available settings are shown below.

Configurable Settings

The following settings can be configured on the Software Client for Windows. 

General Settings

These settings affect the client's behavior both in and out of PCoIP sessions.

Language

Sets the user interface language.

{
    "fullscreen":true,
    "log-level":3
}

broker.domain.com

pcoip://broker.domain.com/connect?
data=eyJhbGciOiJIUzI1NiIsInR5cCI6IkpXVCJ9.eyJmdWxsc2NyZWVuIjp0cnVlLCJsb2ctbGV2ZWwiOjN9.3MRUQ4VeKHbCn

Options Default Type

: German

: Spanish

: French

: Italian

: Japanese

: Korean

: Portuguese (EU)

: Portuguese (Brazil)

: Russian

: Turkish

: Chinese (Simplified)

: Chinese (Traditional)

Not set stringde

es

fr

it

ja

ko

pt

pt_BR

ru

tr

zh_CN

zh_TW

Configurable Settings
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Usage

Connection Settings

These settings control how the Software Client for Windows connects to PCoIP sessions.

Connection Broker

The connection broker's URL. 

Note that this parameter is used by the command line only; when using the URI method, the

connection broker URL is part of the URI (not part of the configuration JWT payload).

Usage

Desktop

The name of the desktop to connect to.

Method Valid Full Alias Example

Command Line  —

URI 

--locale --locale zh_CN

locale loc {loc: "zh_CN"}

Values Default Type

The URL for the connection broker, if present — string

Method Valid Full Alias Example

Command Line 

URI — — — —

--connection-broker -b -b broker.domain.com

Connection Settings
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Usage

Domain

The domain to send to the connection broker.

Usage

Hard Host

If connecting to a PCoIP Remote Workstation Card (also known as a hard host), provide its URL

using this parameter. 

This option is ignored if the  url is provided.

Values Default Type

The name of a desktop to conect to — string

Method Valid Full Alias Example

Command Line  —

URI 

--desktop --desktop myDesktop

desktop vm {vm: "myDesktop"}

Options Default Type

The name of the domain to provide to the connection broker. — string

Method Valid Full Alias Example

Command Line 

URI 

--domain -d --domain domain.example.com

domain dom {dom: "domain.example.com"}

connection-broker

Connection Settings
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Usage

Password

The password sent to the Connection Broker, for logging into a desktop. Transmitting passwords

this way is not recommended.

Usage

Security Mode

The security mode used for validating connections. 

Options Default Type

The URL for the Remote Workstation Card. — string

Method Valid Full Alias Example

Command Line 

URI 

--hard-host -h -h rwc.example.com

hard-host rwc {rwc: "rwc.example.com"}

Note: Command-line only

Passwords can only be sent via the command line. You cannot send a password in a JWT payload.



Options Default Type

A string password. Not set string

Method Valid Full Alias Example

Command Line 

URI — — — —

--password -p -p mypassword

Connection Settings
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Usage

Session ID

This setting launches the JSESSIONID. This parameter is only available via JWT; it cannot be used

on the command line.

Usage

Username

The username sent to the Connection Broker.

Options Default Type

: Verification not required

: Warn, but allow

: Full verification required

: Warn, but allow integer0

1

2

1

Method Valid Full Alias Example

Command Line 

URI  {sec:2}

--security-mode -s -s 2

security-mode sec

Options Default Type

The session ID to launch. Not set boolean

Method Valid Full Alias Example

Command Line — — — —

URI  sessionid sid {sid: exampleSessionID}

Connection Settings
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Usage

USB Settings

These settings control how USB devices connect to PCoIP sessions, including rules for which

devices are allowed to be forwarded.

Disable USB

USB devices are available by default. Use this flag to disable USB connections. This will not

prevent simple human input devices like mice or keyboards from connecting.

Usage

Options Default Type

The username to pass to the connection broker Not set string

Method Valid Full Alias Example

Command Line 

URI 

--username -u -u myUsername

username usr {usr: "myUsername"}

Options Default Type

: disabled

: enabled

false (USB enabled) booleantrue

false

Method Valid Full Alias Example

Command Line  —

URI 

--disable-usb --disable-usb

disable-usb nousb {nousb: true}

USB Settings
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USB Auto-Forward

This setting auto-forwards all non-HID devices to the host.

Usage

Vidpid Auto-Forward

To auto-forward specific devices, provide their VID and PID values separated by a comma ( ).

Multiple values can be provided, separated by spaces. Enclose the list in quotation marks.

Usage

Options Default Type

: Auto-forward USB devices

: Do not auto-forward USB devices

False (do not auto-forward) booleanTrue

False

Method Valid Full Alias Example

Command Line  —

URI 

--usb-auto-forward --usb-auto-forward

usb-auto-forward uaf {uaf: true}

,

Options Default Type

The list of VID,PID values to auto-forward Not set string

Method Valid Full Alias Example

Command

Line

 —

URI 

--vidpid-auto-

forward

--vidpid-auto-forward "aa11,bb22 

cc33,dd44"

vidpid-auto-forward vaf {vaf: "aa11,bb22 cc33,dd44"}
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Vidpid Black List

To block specific devices from auto-forwarding at all, provide their VID,PID values as a space-

separated list using this parameter.

This setting overrides  and the USB dialog in the client interface.

Usage

Session Behavior Settings

These settings control the client's behavior once a session is connected.

Fullscreen Mode

Fullscreen mode enables the display topology to support multiple monitors as an extended

desktop.

If both  and  parameters are sent, the client will launch in Windowed mode.

Usage

usb-auto-forward

Options Default Type

The list of VID,PID values to block Not set string

Method Valid Full Alias Example

Command

Line

 —

URI 

--vidpid-black-

list

--vidpid-black-list "aa11,bb22 

cc33,dd44"

vidpid-black-list vbl {vbl: "aa11,bb22 cc33,dd44"}

fullscreen windowed

Options Default Type

: full screen

: windowed

Not set (uses client's last-set mode) booleantrue

false

Session Behavior Settings
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Windowed Mode

Launches the client in windowed mode.

If both  and  parameters are sent, the client will launch in Windowed mode.

Usage

Log Settings

These settings control logging functionality, including verbosity and file location.

Log Folder

A custom location for client log files.

Usage

Method Valid Full Alias Example

Command Line 

URI 

--fullscreen -f -f

fullscreen full {full: true}

fullscreen windowed

Options Default Type

: Launch in windowed mode

: Do not request windowed mode

 (does not request windowed mode) booleanTrue

False

False

Method Valid Full Alias Example

Command Line 

URI 

--vidpid-black-list -w -w

vidpid-black-list win {win: true}

Options Default Type

A valid system path to a folder Not set string

Log Settings
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Log ID

A unique ID that will identify sessions in all PCoIP log files (including those created by other

components like agents and a connection manager).

Usage

Log Level

Sets the log level. This parameter will override any existing configuration values.

Usage

Method Valid Full Alias Example

Command Line  —

URI — — — —

--log-folder --log-folder path/to/folder

Options Default Type

A unique session identifier Not set string

Method Valid Full Alias Example

Command Line  —

URI — — — —

--log-id --log-id abcde1234

Options Default Type

: Critical

: Error

: Info

: Debug

: Verbose

Not set integer0

1

2

3

4

Log Settings
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Log Prefix

A user-defined prefix for log files. This value will be prepended to the timestamp in the log file

name, like this:

Log files are saved in the location provided by .

Usage

Advanced Settings

Method Valid Full Alias Example

Command Line 

URI  {logl:2}

--log-level -l -l 2

log-level logl

<log-prefix value><timestamp>

log-folder

Options Default Type

A prefix to use in generated log file names Not set string

Method Valid Full Alias Example

Command Line  —

URI — — — —

--log-prefix --log-prefix example-prefix

Caution: General use of these settings is not recommended

These settings are intended for specific use cases, and can drastically alter the behavior of the Software Client for

Windows. Unless you understand what these settings do, and have a clear need to use them, they should be avoided.


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Disable Hotkeys

Session convenience hot keys, such as Ctrl + Delete + F12  (which disconnects a PCoIP

session) are available to users by default. Use this flag to disable all hotkeys.

Usage

Disable Menu Bar

The PCoIP client menu bar is available to users by default. Use this flag to disable the menu bar,

preventing users from accessing it or executing any of its functionality.

Usage

Options Default Type

: disabled

: enabled

false (hotkeys enabled) booleantrue

false

Method Valid Full Alias Example

Command Line  —

URI 

--disable-hotkeys --disable-hotkeys

disable-hotkeys nohot {nohot: true}

Options Default Type

: disabled

: enabled

false (menu bar enabled) booleantrue

false

Method Valid Full Alias Example

Command Line  —

URI 

--disable-menubar --disable-menubar

disable-menubar nomenu {nomenu: true}
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Enable Scaling

This setting enables scaling on the PCoIP Client without having to specify the desktop resolution.

This can only be configured on a single display. This is off by default.

Usage

Force Native Resolution

This setting sets the resolution of the Client monitor to the native resolution when the session

client is launched. This can only be configured on a single display.

Usage

Options Default Type

: scaling enabled

: scaling disabled

false (scaling disabled) booleantrue

false

Method Valid Full Alias Example

Command Line  —

URI 

--enable-scaling --enable-scaling

enable-scaling scale {scale: true}

Note: Windows client only

This parameter is only available on Windows clients. It will have no effect if provided to a Linux or macOS client.



Options Default Type

: force enabled

: force disabled

false (Resolution force disabled) booleantrue

false
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© 2021 Teradici 77



Maintain Aspect Ratio

This setting maintains the display aspect ratio between the host and the Client. Maintaining the

aspect ratio in this way can result in letterboxing if the two devices are naturally different.

This can only be configured on a single display.

Usage

Quit After Disconnect

If this is enabled, disconnecting from the PCoIP session will immediately quit the {! ./common/

name.md! }.The pre-session interface will not be available after disconnecting.

Usage

Method Valid Full Alias Example

Command Line  —

URI 

--force-native-resolution --force-native-resolution

force-native-resolution native {native: true}

Options Default Type

: Maintain aspect ratio

: Do not maintain aspect ratio

False (does not maintain aspect ratio) booleantrue

false

Method Valid Full Alias Example

Command Line  —

URI 

--maintan-aspect-ratio --maintain-aspect-ratio

maintain-aspect-ratio aspect {aspect: true}

Options Default Type

: Quit on disconnect

: Do not quit, show pre-session UI on disconnect

False (does not quit on disconnect) stringTrue

False
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Set Host Resolution

This setting locks the resolution of your host application display. 

Provide the value as a string, made up of the horizontal resolution, the letter "x", and the vertical

resolution. For example, "1024x768".

This can only be configured on a single display.

Usage

Method Valid Full Alias Example

Command Line  —

URI 

--quit-after-disconnect --quit-after-disconnect

quit-after-disconnect qad {qad: true}

Options Default Type

A fixed resolution the host must use. Not set string

Method Valid Full Alias Example

Command Line  —

URI 

--set-host-resolution --set-host-resolution 1024x768

set-host-resolution res {res: "1024x768"}
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System Precedence

The following section outlines the scope precedence commands between the System Scope and 

User Scope. If you are updating individual user settings then the user scope locations and

parameters can be followed. Due to this order of precedence where by the system scope setting

takes precedence over the user scope setting, a change in the user settings may not take effect if

the system scope setting has been updated.

System Scope

User Scope

To add a new key append key=value to the .ini file:

If you are creating a new file, the format of the file should be:

For example:

%PROGRAMDATA%\Teradici\Teradici PCoIP Client.ini

%APPDATA%\Teradici\Teradici PCoIP Client.ini

[General]
<key>=<value>

[General]
security_mode=2

System Precedence
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HID Local Termination Blacklist

Local Termination of Wacom tablets provides the best user experience in networks with high

latency, however some features of the tablet may not be fully supported with local termination. A

HID local termination blacklist has been added to override the preferred local termination mode. 

Devices on the blacklist would be bridged to the remote desktop. To enable the HID local

termination blacklist, add the following setting to %APPDATA%\Teradici\Teradici PCoIP Client.ini.

The vendor and product IDs are separated by a comma and multiple devices are separated by a

space.

For more information on USB Vendor ID/Product ID Auto-Forward, see here.

Troubleshooting HID Local Termination Blacklist

The following lines should appear in the PCoIP Agent log if a device is using HID local termination:

localtermination_black_list "vid,pid vid2,pid2"

pcoip server log: `LVL:2 RC: 0 MGMT_KMP :Client added HoIP device (id:0x000a0005) 
with vendor id=0x056a, product id=0x0391`
pcoip client log: `LVL:2 RC: 0 MGMT_USB :HoIP supported device detected (Vid: 
0x056a, Pid: 0x0391), using HoIP protocol for local termination'

HID Local Termination Blacklist
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PCoIP High Performance Client

The PCoIP Software Client has a high performance mode that can be enabled through the 

 file. The  file can be found at 

%appdata%\Teradici\Teradici PCoIP Client.ini.

The PCoIP High Performance client enables higher frame rates with fewer dropped frames than

the default PCoIP Software Client. This mode is especially beneficial for 4K video workloads up to

30fps.

To enable the high performance mode of the PCoIP Client you must edit the 

 file. To enable the high performance mode, set the following value:

You can use the  parameter which will automatically forward USB

peripherals such as Wacom Tablets and Game Pads, see here.

Additional information on the high performance client:

• Compatible for fullscreen, all monitors only. You cannot use windowed mode.

• Limited menu options are available.

Teradici PCoIP Client.ini Teradici PCoIP Client.ini

PCoIP High Performance Client Limitations

The PCoIP High Performance Client is recommended for customers wishing to optimize the presentation of high

frame rate content such as video or animations. Teradici does not recommend using the PCoIP High Performance

Client for majority use cases, and instead it is a case specific enhancement at this time as it contains certain

limitations.



Teradici PCoIP 

Client.ini

%appdata%\Teradici\Teradici PCoIP Client.ini

enable_high_perf_client=1

--vidpid-auto-forward

PCoIP High Performance Client
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Menu Options on the High Performance Client

The following menu options are available on the High Performance Client:

• Teradici PCoIP Client

◦ Quit Teradici PCoIP Client

• Connection

◦ Send Ctrl+Alt+Del

◦ Disconnect (To disconnect use ctrl-alt-~ )

• View

◦ Minimize Client (You can minimize the client by using ctrl-alt-m )

◦ Tablet Monitor

◦ Tablet Orientation Left-handed

◦ PCoIP Ultra AVLock

Statistics Overlay on the High Performance Client

The statistics overlay feature on the High Performance Client displays the following information:

• Codec: This reports the current PCoIP encoding that is in use. Possible values for this include

PCoIP Ultra CPU, PCoIP Ultra GPU and PCoIP.

• Encoding: This reports the color space that is being used to encode the information. PCoIP

and PCoIP Ultra CPU offload will report RGB 8:8:8 which means full 8 bit RGB pixels are being

used. For PCoIP Ultra GPU optimization, either YUV 4:4:4 or YUV 4:2:0 will be used, depending

on the system configuration.

• HW Decode: This reports whether or not the PCoIP Client is decoding the frames using built-in

GPU hardware decoding.

• FPS: This reports the current frames per second that are presented on the PCoIP Client.

The image below is an example of a statistics overlay on the High Performance Client:

Menu Options on the High Performance Client
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To enable the statistics overlay of the PCoIP Client you have to edit the 

 file. To edit the file you can use tools like "vi", "nano" or "vim"/ Please see the manuals

of your prefered text editor on how to use it. To enable the statistics overlay on the high

performance client, add the following to the  file:

To toggle visibility of the statistics overlay press CTRL+Win` .

Teradici PCoIP 

Client.ini

Teradici PCoIP Client.ini

enable_high_perf_client_stats_overlay=1

Statistics Overlay on the High Performance Client
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Custom Logo in Pre-Session

The PCoIP Software Client can be configured to place a custom logo beside the PCoIP logo at the

bottom right corner of the PCoIP Software Client login dialog. For best results, the logo should be a

.png file with a transparent background, and ideally should be 245x100 or smaller. The image must

be named customlogo.png.

• Windows location: %PROGRAMDATA%/Teradici/PCoIPClient/

Custom Logo in Pre-Session
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PCoIP Software Client Security Modes

The PCoIP Software Client uses certificates to verify the identity of the host to which it connects.

The security mode is configured by the  setting in the Teradici PCoIP Client

configuration file, which is described next. Three security mode options are available:

• security_mode=0: verification is not required A red, unlocked padlock icon appears on the

client login screen.

• security_mode=1: warn but allow (default) If a certificate cannot be verified, an 'untrusted

server' warning displays and a red, unlocked padlock icon appears on the client login screen.

Users still have the option of connecting.

This mode is used if  is not set in the configuration file.

• security_mode=2: full verification is required Users cannot connect unless a certificate can be

verified.

Setting the Security Mode

Use the following procedure to set the PCoIP Software Client's security mode.

To set the security mode for the PCoIP Software Client:

1. Close the PCoIP Software Client.

2. Open a Windows Explorer window and navigate to %appdata%\Teradici.

3. Using a text editor, open Teradici PCoIP Client.ini.

4. Add the line  to the file, where  is your desired security

option (0, 1, or 2).

security_mode

security_mode

PCoIP sessions are always encrypted

Your PCoIP session is still encrypted and secure if you connect with security mode 0 or 1. The red padlock icon

indicates that the certificate presented by the host is not signed by a trusted certificate authority in the client’s

certificate store, not that the session is insecure.



security_mode=<value> <value>

PCoIP Software Client Security Modes
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5. Save the file.

Setting the Security Mode
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Installing the Internal Root CA Certificate in a PCoIP
Client

Your root CA certificate must be installed in any PCoIP client that will be used to connect to the

PCoIP Agent.

Installing Root CA Certificates in the PCoIP Software Client for
Windows

To import the root CA certificate for the PCoIP Software Client for Windows:

1. Copy your root CA certificate file (*.crt) to a directory reachable by your Windows client.

2. Open the Microsoft Management Console on the agent machine:

a. Press + r  to open the run dialog

b. type mmc and press Enter .

Root CA Certificate must have a .crt extension

You must change the root CA certificate's extension from .pem to .crt before installing it on a PCoIP Software Client.



Windows must trust your root certification authority

When you use your own private key and certificate, you must add your internal root CA certificate to the Windows

Trusted Root Certification Authorities certificate store on the client computer.

Users without a trusted root CA will receive an Unable to get local issuer certificate error and fail to connect.



Active Directory group policies

For information on using Active Directory Group Policy to distribute certificates to client computers, see http://

technet.microsoft.com/en-us/library/cc772491.aspx.


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3. Add the Certificates snap-in:

a. Select File > Add/Remove Snap-in.

b. Select Certificates from the Available snap-ins list and then click Add.

c. Select My user account and then click Finish.

d. Click OK.

4. Import the root CA certificate:

a. Expand Certificates - Current User.

b. Right-click on Trusted Root Certification Authorities, select All Tasks > Import from the

context menu, and then click Next.

c. Use the Browse button to navigate to the directory where your root CA certificate is

located and select your root CA certificate.

d. Click Open and then Next.

e. Select the option to place all certificates in the Trusted Root Certification Authorities

certificate store.

f. Click Next and then Finish.

g. At the security warning, click Yes.

After the certificate installs successfully, it appears in the Trusted Root Certification Authorities >

Certificates list.
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Recovering a USB Driver with the PCoIP Software
Client

When using USB drivers on the PCoIP Software Client for Windows you can sometimes encounter

issues around versioning of the USB hub filter, as displayed in the error message below:

If you encounter this issue or another issue relating to your USB driver, Teradici recommends

carrying out the following steps:

1. Uninstall the PCoIP Client.

2. Reboot your machine.

3. Open the Registry Editor editor.
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4. Search for fuhub under HKLM. The file path is 

Computer\HKEY_LOCAL_MACHINE\SYSTEM\ControlSet001\Services\fuhub. 

5. Remove the registry key which is the item in the left pane with the folder icon, in this case it is

the fuhub key, containing fusbhub. If you cannot remove this registry key note the .inf file

name associated with the registry entry. The .inf file name usually starts with oem, for

example oem9.inf. Open the commandline and run the following prompt: 

6. Keep repeating step 5 until fusbhub is completely removed from the registry editor.

7. Reboot your machine.

8. Install the PCoIP Client.

pnputil -f -d oem9.inf
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Support and Troubleshooting

If you encounter a problem installing or using the Software Client for Windows, there are a number

of troubleshooting and support resources you can access.

• We maintain an extensive knowledge base which answers many questions and documents

solutions to common problems. The knowledge base is part of the Knowledge Center; click on

the Articles tab to access it, or enter a search query in the search field at the top of the page.

• We host a community forum, allowing you to ask questions and get answers from other IT

professionals and our support team, which monitors this channel. The forum is part of the 

Knowledge Center; click on the Discussions tab to access it.

• If you need more help, open a support ticket and our support team will engage with you

directly.

Creating a Support Bundle

Our support team may request a support bundle from you. The support file is an archive

containing logs, diganostic data, and system information that helps the team diagnose problems.

To create a support file using Windows:

1. From the Windows start menu, select PCoIP Client Support Bundler.

2. Run the bundler as an administrator.

3. Click Yes if the User Account Control panel appears.

To create a support file using PowerShell:

1. Open a PowerShell command prompt.

2. Set the PowerShell execution policy to enable the script to run:

3. Launch the support bundler:

Set-ExecutionPolicy -Scope Process -ExecutionPolicy Bypass
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The support file will be created and placed in $env:ProgramData\Teradici\Support\. A

new File Explorer window will open with the generated support file selected.

Finding Your Client Version

You can find your Software Client for Windows version number from the pre-session interface, or,

if you're already in a session, from the client menu bar.

• Pre-session: If you are not in a session:

◦ Click on the hamburger icon, found at the bottom left of the screen beside the Cancel

button. 

◦ From the context menu that appears, select About.

& 'C:\Program Files (x86)\Teradici\PCoIP Client\bin\pcoip-client-support-
bundler.ps1'
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◦ Find the version number in the information window that appears.

• In-session: If you are in a session:

◦ Find or reveal the client menu bar

◦ Select Anyware PCoIP Client > About Anyware PCoIP Client.

◦ Find the version number in the information window that appears.
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PCoIP Client Logging

The Software Client for Windows writes log files that document its processes and interactions

with other services such as brokers and agents. These files are invaluale in diagnosing problems.

This page describes how logs are handled and where they can be found.

Log Location

Client logs are placed in  by default. Log locations

can be overriden via launch configuration if required.

 is the name of the user that launched the client.

Log Levels

Log verbosity is defined by a level, respresented by an integer from 0 to 4:

• : Critical messages only

• : Error messages and higher

• : Info messages and higher (default)

• : Debug messages and higher

• : All messages (maximum verbosity)

The default setting is , recording informational messages and higher.

The log level can be changed in any of the following ways:

• Via command-line launch: This method provides the log level inline during a command line

launch; see Log Level in the configuration section for details. 

• Via the client UI: 

◦ From the client's menu icon, click Settings.

◦ Set the log level as desired.

%localappdata%\Teradici\PCoIPClient\logs

<Username>

0

1

2

3

4

2
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◦ Click Save.

Log Session IDs

The Software Client for Windows creates a unique session ID when a new session is established,

and distributes that ID to all components in the system. When PCoIP components generate log

messages, they are prefixed by this unique session ID, allowing administrators and support to

easily group events by session across multiple components:

For example:

Log messages that do not pertain to a specific session will show a string of zeroes in place of the

session log ID number.

This session ID can be overridden by providing a custom string during a command line launch; see

Log ID in the configuration section for details.

Tip: Reporting issues to support

When you are reporting an issue to support, set the log level to  (debug) first, and then reproduce the issue and

create a support bundle. This will capture much more detail than the default setting, making diagnostics more

effective.



3

yyyy-mm-ddThh:mm:ss.ffffffZ xxxxxxxx-xxxx-xxxx-xxxx-xxxxxxxxxxxx > …

2015-11-06T08:01:18.688879Z 4208fb66-e22a-11d1-a7d7-00a0c982c00d > …
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